<table>
<thead>
<tr>
<th>Session Number(6-1, 6-2 6-3, 6-4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>{10/12/2017}</td>
</tr>
<tr>
<td>8:30AM to 04:30PM</td>
</tr>
</tbody>
</table>

**Introduction to Crystal Reports**

For Sage 300

**Progressive Reports**

*Getting the Answers*
This manual covers Crystal Reports 2013 for Sage 300 (Formally Timberline Office).

All rights reserved. No part of this manual may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or by any information storage and retrieval system, without the permission in writing from Progressive Reports.

Disclaimer:
Information in this manual is subject to change without notice. Company names, dates and other information used are examples only and are fictitious. The information in this manual is distributed “as is” without warranty. While every precaution and effort has been taken to assure the quality and accuracy of the information contained herein, Progressive Reports assumes no liability to any person or entity with respect to any loss or damage caused by or presumed to be caused by the instructions contained in this manual or by the software described in it.

For additional information contact:
Progressive Reports
971-223-3658
www.progressivereports.com
Introduction

What You Will Learn

Welcome to this Crystal Reports Introductory class. This course is designed to teach new users design and formatting techniques that will serve them well as they build upon this introductory knowledge. It is divided into discussion of concepts and activities.

This guide is intended to help meet the following objectives:

- Introduction to Crystal Reports 2013 R2
- Creating Crystal Reports from scratch
- Learn how to connect to the Sage 300 database via ODBC
- Learn how to add fields to the report
- Understanding the various sections
- Formatting fields and sections
- Filtering Reports to return just the data you want
- Linking tables
- Grouping your data for better display
- Summaries including Sub and Grand totals
- Introduction to Formulas (Sneak Peak)
- Special Sage 300 functions and formulas that must be added to each Crystal Report
- Adding reports to the Sage Report menu
- And many more tips and tricks along the way!
Crystal Reports 2013

Crystal Reports has been the worldwide leader in database report writing software for decades. The WIZIWIG and drag and drop report style is better than most other report packages in the industry and has helped keep Crystal Reports a leader in the field.

Crystal Reports is owned by SAP, and used by millions of companies around the world. The software is available to buy online at http://www.crystalreports.com. Each person who wants to create reports in your company will need access to the software. However, after a report is created, it can often be run from the Sage 300 menu eliminating the need to own multiple copies of Crystal Reports. In addition to running reports from within Sage 300 you can use third party Crystal Viewers to preview and print your reports from your desktop. I particularly like one called Data Link Viewer by Millet Software.

Crystal Reports 2013 R2 for Sage 300

With the upgrade to Sage 300 14.1 version and beyond, Sage CRE has switched from using the Crystal XI R2 to using Crystal Reports 2013 R2 version. This was a big jump in Crystal Versions. Sage leapfrogged over two other versions of Crystal to get on the latest and greatest version currently available.

There are many differences between Crystal XI and Crystal 2013. And though most of these differences are very good and will help you build better reports than ever before. It is important to know that some of your custom reports (Not canned) may not work without some modifications. For one thing, there is now an upgrade Crystal Reports feature that comes with Sage 300. You can find it by going to select All Programs> Sage> Sage300Construction and Real Estate > Reporting and Other Tools, right-click Upgrade Crystal Reports, and then select Run as administrator. Even though this is a class on canned reports it is important to know about this tool. Why is that? Because if you have already been modifying canned reports, most likely you have been naming them with a custom name so they wouldn’t get overwritten with Sage updates. Each of these formerly canned reports (Now custom) must be upgraded using this tool before using them with Sage 300 14.1 or higher. Once a report has been upgraded you will find a formula in that report named SageCREReportVersion. Inside the formula it will list the version of Sage it was upgraded to.
ODBC

We can’t have a discussion about modifying canned Crystal Reports for Sage 300 without first discussing ODBC. This point is often lost in the discussion and it is the foundation of a successful experience modifying custom reports.

ODBC stands for Open Database Connectivity and was introduced into the computer world many decades ago. It allows two programs to speak to each other and in some cases pass data back and forth between them. Think about it like this. A German and a Frenchman may not speak each other’s languages (similar to two propriety software packages) however if they both speak a third language such as English then the will be able to communicate with one another. ODBC is like a meeting place where diverse software such as Sage 300 and Crystal Reports that do not know anything about each other, can speak a common language.

That language is SQL or Structured Query Language. When Crystal Reports runs a report it actually sends to Sage 300 instructions written in SQL on what data it wants returned. Both the sender and the receiver can understand the request.

Think about it like this. A German and a Frenchman may not speak each other’s languages (similar to two propriety software packages); however, if they both speak a third language such as English then they will be able to communicate with one another. ODBC is like a meeting place where diverse software such as Sage 300 and Crystal Reports that do not know anything about each other, can speak a common language. That language is SQL or Structured Query Language. When Crystal Reports runs a report it actually sends to Sage 300 instructions written in SQL on what data it wants returned. Both the sender and the receiver can understand the request.

For us to be able to not only modify a canned Crystal Report but to preview them while in Crystal or to introduce new fields and tables we must first setup ODBC on our PC first. Therefore, when back at your PC where you have both Sage 300 and Crystal Reports installed you will need to setup ODBC so that you can do those edits and previews. If you cannot change your ODBC settings in the way you’re about to learn, then you may not have rights to do so and you will need to get your IT Dept. involved to give you those rights. You do not need to set this up each time you modify a report. You do this once for the most part and often don’t have to change it for years.

Almost everyone is now using a 64-bit machine (PC) with a 64 bit operation system such as Windows 7 or Windows 8 & 10. Sage 300 still uses a 32-bit ODBC driver. They are not alone, many other software companies including some of Sage 300 competitors still use a 32-bit ODBC driver. By default when you navigate to your computers control panel looking for the ODBC setup area you will find the 64 bit in almost every case. You won’t realize it is the 64 bit spot but it will be. Therefore you need to remember that you must navigate to the 32-bit ODBC administrator area. This is hidden a bit but you can find it.
There are two ways to find the 32-bit ODBC setup area. The first is to simple navigate to by going to Start menu, select All Programs> ODBC > 32bit ODBC Administrator to open the Data Source Administrator window. However, my favorite way is to simple type in 32 at the Windows start search area. That almost always brings up a list of files that start with 32 and the 32 ODBC Administrator will be at the top of the list.
ODBC Overview

In this section we will cover:

- What is it?
- Setting Up ODBC
- The Magic of the “Timberline Data Source”

**ODBC**—stands for Open Database Connectivity. ODBC came about in the 80’s and revolutionized how databases talked to each other. Basically it allows two products that may have nothing in common to communicate with each other and pass data back and forth between each other. This could be Excel and Sage 300 or it could Crystal and Sage 300. The two products involved don’t really matter; they just have to have ODBC drivers installed on the machine you are using to communicate with each other.

**Note:** Not that anyone will ever ask you, but ODBC talks in the language of SQL or Structured Query Language. Those of you who know SQL can further customize/optimize your reports directly using SQL Commands. The rest of us don’t need to be worried, Crystal handles it all just fine for us too.

**Setting Up ODBC:**

Sage 300 comes with an ODBC Driver that automatically works its magic if you just want to run Crystal Reports from the Sage 300 reports menu. However, since we are in this course to be the report writers we need to setup ODBC on our machines so that Crystal can communicate with Sage 300 during the report building and testing phase. Once the report is deployed on the Reports menu in Sage 300 it will run without problems, if we just follow a few steps.
Pre-Activity 1: Setting up ODBC on your computer:

From the Control Panel

1. Open ODBC Data Sources 32 bit. (Start menu > Control Panel > Administrative Tools > ODBC Data
   
   - On Windows 8 & machines just start typing 32 from the Start page and you’ll quickly see an option to pick 32 ODBC Administrator.
   
   - On Windows 7 Machines click the Start button and then type 32 in the search box and you’ll quickly see an option to pick 32 ODBC Administrator.

2. From the User tab, select or highlight the Timberline Data Source.

3. Click [Configure].

4. Click on [Select Folder] and pick Timberline Construction Sample Data or your Live Data folder if doing this activity in your office.
5. Click on the Option Button at the bottom right and make sure to **Remove** the check mark from **Shorten field and table names**. Leave the check mark on **Use maximum table segment size** checked.

6. Click [**OK**] twice.

**What’s so Magical about the “Timberline Data Source” ODBC DSN**

In almost every case you want to build Crystal Reports using the DSN (Data Source name) “Timberline Data Source”. By using this DSN, Sage 300 takes over when the report is run from the reports menu and does the following.

- Automatically switches to the data folder you are running the report from. This is critical for companies who have more than one data folder.

- Allows the use of all the Sage 300 functions such as:
  - Asking which file to use (New, Current, History)
  - Letterhead style
  - Automatically sign you in so you are not asked your User name and password.
  - And many more functions described in the Users Guide.PDF installed with Sage 300.

- Automatically sets itself back up if the DSN is ever deleted or a new version of Sage 300 is installed.

- Create Range Button when running reports from the Sage 300 reports menu.
Design Basics

This section discusses the following:

- Creating a New Report
- Modifying Table Selection & Data Options
- Linking
- Areas of the Design Window
- Menu Bar Functions

Creating a New Report

There are two basic ways to create reports. One is to use a Report Wizard that Crystal Reports 2013® provides for you. The other is to create the report from scratch. For this class, designs will be created from scratch using the Construction or Gold Coast Group sample databases.

To use Crystal Reports 2013® with Sage 300 applications not including Billing (Invoices), Service Management and Purchasing and Inventory applications, you must specify a database location within the Timberline Data source ODBC DSN. This allows the two applications to communicate with each other.

When starting Crystal Reports 2013, the following Start Page window should display. You will choose Blank Report to start a design from scratch. Using the Wizard will simply hide options and make decisions for you and you won’t become as good a report writer if you let Crystal make the decisions for you.
After you click **Blank Report**, select “Create New Connection”. Click the plus sign to expand, and then select ODBC (RDO).

**Note:** If you are working on a report for Service Management, select “Create New Connection”, then select the Btrieve option on this list, find the Field.ddf file for that dataset and select it.

Find your Timberline Data Source DSN and Click [Next].
Enter your **User Name** and **Password** for Sage 300 (if applicable) or leave blank then click the **[Finish]** button.
The DSN lists available tables. Tables are typically equivalent to records in Sage 300. You only need to select the table with the information needed.

Select the tables you need for your report. If you click [OK] without selecting tables, you get a blank report. Tables can be added and removed later.

Click the add arrow to select individual tables. You can also hold down the CTRL key on the keyboard to select multiple tables then add. The double arrow button will add all the tables from a data source.
Modifying Table Selection & Data Options

Add a Table

If you have started a report and need to add a table, go to the Database menu and select Database Expert. Select the tables to be included, highlight, and click the add arrow button, and then click [OK]. The visual linking expert window will appear to set up new links.
Remove a Table

If you previously added too many tables and now need to remove a table that is not being used, go to the Database menu and select Database Expert. Select the table to remove and click on the remove arrow button. This will also remove the related links for that table from tables that remain on the report.

Saved vs. Refreshed Data

Saved Data means a copy or snapshot of the data used when the report was created is saved with the design as well as specifications about the design. When the data is not saved with the report, you must refresh
each time you print the design. It is not advised that you use “Save Data” with Sage 300. It can cause results to not be up to the minute when the report is used on one of the Sage 300 report menus.

Areas of the Design Window

There are five main areas in the design window:

1. Report Header
2. Page Header
3. Details
4. Page Footer
5. Report Footer

Areas are also referred to as sections and determine how often the information should print. Each report can have multiple areas of the same type.

<table>
<thead>
<tr>
<th>Design</th>
<th>Report Header</th>
<th>Page Header</th>
<th>Details</th>
<th>Report Footer</th>
<th>Page Footer</th>
</tr>
</thead>
</table>

**Report Header:** The Report Header prints on the top of the first page. It typically includes a company logo, name of the report, etc.

**Page Header:** The Page Header prints at the top of every page of the report unless conditioned out. It normally includes date, page numbers, column headings, etc.

**Details:** The Details area is where the fields you want to print in the body of the report will be placed. The information will print once per record. It normally includes the bulk of fields that are printing on the report.
Report Footer: The Report Footer prints at the end of the report. It normally includes report totals are placed here.

Page Footer: The Page Footer prints at the bottom of every page of the report. It normally includes, page numbers, comment lines, etc.

Note: When groups are added, additional sections appear.
Adding Fields to the Report

From the [View] Menu in Crystal Report select [Field Explorer]. That way you will see the list of tables, fields, formulas etc. in a box to your right.

The window contains all your database fields such as the Invoice Number, Invoice Date and Invoice Amount etc. In addition, it will be this window that you come back to in order to write formulas, build Parameters and much more. You drag fields and objects from this window directly onto your to build your report. You will often hide the Field Explorer so you can have more room to see the design. You can always bring back Field Explorer by selecting it from the View menu or its icon.

OK, that should be just enough information for you to get started building your first Crystal Report. One thing to remember...you can’t break your data when writing reports. So don’t worry about hurting the data. That being said a report can return incorrect results based on how it is built and we will discuss this more as we move forward today.
**Activity One: Build a New Report from Scratch**

Use the Sage 300 Construction Sample Data. Create a report by doing the following:

- Use The Timberline Data Source DSN when building Crystal Reports for Sage 300.
- Open Crystal Reports and start a **New** report from Scratch. Remember, don’t use the wizard but rather pick “**Blank Report**”.
- Select the **APM_Master__Invoice** table and push that table from the left side to the right side in the **Database Expert**.
- Click **[OK]**.
- **Drag** the following fields from the **Field Explorer** onto the report and place them **directly in the Detail section**:
  - Vendor ID
  - Invoice
  - Description
  - Amount
  - Status
- Preview the report by click the **[F5]** Key or from the **View** Menu select **[Print Preview]**.
- If you see data then you know your report is successfully connected to your data.
- From the **File** Menu, **Save** your report as **Report 1A**.

![Crystal Reports for Sage - [Report1]](image-url)
Formatting the Report

Move fields

Any field on the report can be moved to any other place in the report by simply clicking and dragging the field to its new place on the report. You can move fields between sections too.

Resize objects

Fields on the report can be resized either horizontally or vertically. Click on the field. Small solid boxes, called handles, will appear on both the vertical and horizontal sides of the field. Click and drag on the box, and the field will be resized to the new dimension. You must resize fields when the font makes the field print larger than the area allowed by the field borders.

![Handles](image)

Resize Report Sections

Sections of the report (i.e. Report header, Page Header, Details, Page Footer, Report Footer) can also be resized. A gray bar separates each section. Click on the gray bar and move the section line either up or down to resize the section.

![Section resize](image)

*Note:* A section will only resize until it meets the border of a database field. It does not move fields.

Multiple Field Selection

More than one field can be selected at one time for moving, resizing or other formatting. To select more than one field, select one of the following:

1. Hold down the Ctrl key and click on each of the fields that you want.
2. Draw a box so it touches the fields that you want. To create the box, click and hold on a clear portion of the report. As you start to move your mouse, a faint dotted box will appear. Drag it so it touches the fields you want. The box doesn’t have to be completely around the fields. Once you have all the fields, release your mouse. All the fields that were touched by the box line have handles on the vertical and horizontal sides.
**Field Format**

When you right-mouse click on a field, the following context menu appears. Choose Format Field from the menu to modify the appearance of the data in the field. Depending on the type of field, different options may be available after selecting.

For alpha-numeric fields:

**Format, Common tab**  
(Option to Suppress Embedded Blanks)
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppress</td>
<td>Mark to not print this field.</td>
</tr>
<tr>
<td>Horizontal Alignment</td>
<td>Select from Default, Left, Right, or Center.</td>
</tr>
<tr>
<td>Can Grow</td>
<td>Mark to allow the field to get larger. You can also set a maximum number lines.</td>
</tr>
<tr>
<td>Text Rotation</td>
<td>Rotate text 0°, 90°, or 270°.</td>
</tr>
<tr>
<td>Suppress If Duplicated</td>
<td>Mark to control how often a field should repeat printing when it remains the same.</td>
</tr>
</tbody>
</table>

**Suppress Embedded Field Blank Lines**

Mark when you have a text field where multiple fields have been inserted into the text field and may be blank. For example, place all address fields into a text box. Then mark the field to suppress embedded blank lines for the Address 2 line when no data exists for it.
For Numeric Fields:

Format, Number Tab

Currency Symbol Options

Number Options
Activity Two – Start with report 1 and Save as Report 2

- Arrange the fields in the following order across the page:
  1. Invoice
  2. Description
  3. Vendor
  4. Status
  5. Amount

- Resize the fields to match the data printing. Also change the size of the headings.
- Format the Amount field to print with two decimal places, a comma and currency symbol once per page.
- Right justify the Invoice field and Center justify the Status field.
- Change the column headings to print bold and blue.
- Save as report 2.
- Preview the report.
Working in a Report

You can use all of the following in a report:

- Database Fields
- Formula Fields
- SQL Expression Fields
- Parameter Fields
- Running Total Fields
- Group Name Fields
- Special Fields

To access these, use the Field Explorer. To open the Field Explorer, select it from the Toolbar or go to the View menu and select Field Explorer. The Field Explorer will display on the right of the Design view by default; however, it can be moved to another section of the screen. When the option list shows the symbol, it means there is more to display related to the option. Double click the option or click on the symbol to expand it.
Adding Fields to a Report:

Find the field or formula you want to insert and do one of the following:

- Double-click, and then move the mouse where the field should be placed.
- Press the Enter key or highlight and select the Insert Fields option (circled below) in the Field Explorer toolbar. Once selected, move the mouse to the area of the report where the field should be placed and click once.
- Highlight and drag the field to the location for placement.
- To select multiple fields, hold down the Ctrl key on the keyboard as you make your selections. Then move your mouse where the fields should be inserted. Fields are inserted left to right from first to last selection.

Note: Once a field has been used on a report, it displays a checkmark by the field. This check mark also displays if the field has been used in a formula, and not specifically as a report field.

Browsing Fields

You have the ability to browse any database field by selecting Browse from the right-mouse context menu. This shows you the first 100 records for that field in the current database being used. This can be helpful to see the actual values and how they are being stored in that field.
Inserting Text Objects

**Text objects** are fields containing text, database fields, formulas or a combination. You have total editing capabilities in the text object. To create a text field, use the Insert Text Object bitmap on the toolbar or Text Object from the Insert menu. The field is inserted as a blank area and you can type in the text or pull in other types of objects.

![Text Object Example](image)

**Editing Text Fields**

To edit the text in a text field, right-mouse click on the text field and choose Edit Text Object from the context menu.

**Pulling a Database Field into Text Fields**

To combine text and database fields, create the Text Object first. Then, find the data field to pull in and drop the Data Field within the Text Box. The following shows the Text Object with the Print Date from Special Fields pulled in.

```
This is a text field and system field: Print Date
```

The following is the printout of this combination field:
### Note:
When moving fields, use caution moving database fields over text fields. The system assumes you want to combine the two fields as you hover over during the move. The mouse cursor changes momentarily to show when a combination would occur.
Inserting Lines and Boxes

Reports can be enhanced with lines and boxes. To insert, go to the Insert menu and select Lines or Boxes. Optionally, you can use the bitmap on the supplementary toolbar.

For **Lines**, your cursor changes to a pen and you can draw the line where you want it. To edit the looks of the line, right-mouse click on the line and select **Format Line** from the context menu.

![Format Editor](image)

You have style options of None, Single, Dashed or Dotted. You can select the width and color and where and when to print the line.

For **Boxes**, your cursor changes to a pen and you can draw the box around an area of fields. Boxes can cross section borders.
Inserting Pictures

To insert a picture, go to Insert > Picture and find the image file to be inserted. After you click Open, the file is attached to the mouse. Click in the design where the image should be placed. Below the logo file (A jpg image file) has been placed in the Report Header section.
<table>
<thead>
<tr>
<th>Invoice</th>
<th>Description</th>
<th>Vendor</th>
<th>Status</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>987</td>
<td></td>
<td>100</td>
<td>Open</td>
<td>14,555.00</td>
</tr>
<tr>
<td>5337</td>
<td></td>
<td>100</td>
<td>Open</td>
<td>1,328.00</td>
</tr>
<tr>
<td>14598</td>
<td></td>
<td>100</td>
<td>Open</td>
<td>5,000.00</td>
</tr>
<tr>
<td>14900</td>
<td>custom paint</td>
<td>100</td>
<td>Open</td>
<td>700.00</td>
</tr>
<tr>
<td>14907</td>
<td></td>
<td>100</td>
<td>Open</td>
<td>1,574.00</td>
</tr>
<tr>
<td>15678</td>
<td></td>
<td>100</td>
<td>Open</td>
<td>1,250.00</td>
</tr>
<tr>
<td>30112</td>
<td>PO#1002 WO 23454</td>
<td>100</td>
<td>Open</td>
<td>116.50</td>
</tr>
<tr>
<td>049510</td>
<td>10% complete billing</td>
<td>100</td>
<td>Open</td>
<td>8,250.00</td>
</tr>
<tr>
<td>049512</td>
<td>10% complete billing</td>
<td>100</td>
<td>Open</td>
<td>6,790.00</td>
</tr>
<tr>
<td>149412</td>
<td></td>
<td>100</td>
<td>Open</td>
<td>1,500.00</td>
</tr>
<tr>
<td>658791</td>
<td>PO#1000</td>
<td>100</td>
<td>Open</td>
<td>48.00</td>
</tr>
<tr>
<td>58584</td>
<td>Insulation 40R</td>
<td>101</td>
<td>Open</td>
<td>4,300.00</td>
</tr>
<tr>
<td>14926</td>
<td></td>
<td>101</td>
<td>Open</td>
<td>4,500.00</td>
</tr>
<tr>
<td>24582</td>
<td></td>
<td>101</td>
<td>Open</td>
<td>1,500.00</td>
</tr>
</tbody>
</table>
### Activity 3: Use your report 2 as the basis for these changes:

- Save as Report 3.
- Create a text object as a report title. Call this Title “*Invoices Report with Status*”.
- Increase the font size of the text up one stop, such as from 8 to 10 or 10 to 12.
- Add a border and drop shadow.
- Change the color of the text inside the title.
- Center the text object so it will print in the center of the page (Extra Credit).
- Save Report again with your changes and preview.

```
<table>
<thead>
<tr>
<th>Invoice</th>
<th>Vendor</th>
<th>Description</th>
<th>Status</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>914</td>
<td>1020</td>
<td>07-109</td>
<td>Fully paid</td>
<td>16,954.00</td>
</tr>
<tr>
<td>1193</td>
<td>1020</td>
<td>07-030</td>
<td>Fully paid</td>
<td>293.00</td>
</tr>
<tr>
<td>1140</td>
<td>1020</td>
<td>07-020</td>
<td>Fully paid</td>
<td>1,290.00</td>
</tr>
<tr>
<td>1273</td>
<td>1020</td>
<td>08-006 50043</td>
<td>Fully paid</td>
<td>450.00</td>
</tr>
<tr>
<td>3220</td>
<td>1020</td>
<td>11-100</td>
<td>Fully paid</td>
<td>390.00</td>
</tr>
<tr>
<td>4816</td>
<td>1020</td>
<td>12-007 60213</td>
<td>Fully paid</td>
<td>300.00</td>
</tr>
<tr>
<td>4822</td>
<td>1020</td>
<td>12-007 68213</td>
<td>Fully paid</td>
<td>437.50</td>
</tr>
<tr>
<td>4526</td>
<td>1030</td>
<td>11-100 64473</td>
<td>Fully paid</td>
<td>59.50</td>
</tr>
<tr>
<td>4783</td>
<td>1030</td>
<td>05-027 9974</td>
<td>Fully paid</td>
<td>119.27</td>
</tr>
<tr>
<td>8212014</td>
<td>1030</td>
<td>14-006 68875</td>
<td>Fully paid</td>
<td>27.25</td>
</tr>
<tr>
<td>023813</td>
<td>1031</td>
<td>V-26 69228</td>
<td>Fully paid</td>
<td>95.00</td>
</tr>
<tr>
<td>16940</td>
<td>1032</td>
<td>7N07550</td>
<td>Fully paid</td>
<td>50.00</td>
</tr>
<tr>
<td>16805</td>
<td>1032</td>
<td>V35 68893</td>
<td>Fully paid</td>
<td>60.00</td>
</tr>
<tr>
<td>011414</td>
<td>1032</td>
<td>Smog test 2000 GMC UT</td>
<td>Fully paid</td>
<td>90.00</td>
</tr>
<tr>
<td>54169</td>
<td>1035</td>
<td>13-101</td>
<td>Fully paid</td>
<td>120.00</td>
</tr>
<tr>
<td>001810</td>
<td>1040</td>
<td>G5 Chev 2590</td>
<td>Fully paid</td>
<td>231.64</td>
</tr>
<tr>
<td>123167</td>
<td>1050</td>
<td>Service Charge</td>
<td>Fully paid</td>
<td>8.35</td>
</tr>
<tr>
<td>140180</td>
<td>1060</td>
<td></td>
<td>Fully paid</td>
<td>445.47</td>
</tr>
<tr>
<td>140210</td>
<td>1060</td>
<td></td>
<td>Fully paid</td>
<td>111.37</td>
</tr>
<tr>
<td>140000</td>
<td>1060</td>
<td>#V86016</td>
<td>Fully paid</td>
<td>175.13</td>
</tr>
</tbody>
</table>
```
Menu Bar Functions

All of the icons on the menu bar are shortcuts for tasks that are found on the menus. By placing the mouse cursor over the icon, it displays the name of the task.

Menu bar functions used most often:

- **New**: Use to create a new design.
- **Open**: Use to open a new design. Default to open where File, Options, New Report tab location is set.
- **Save**: Use to save the current active design as the same name.
- **Preview**: Use to preview the report on screen. Editing can be done in Design or Preview mode. To get back to Design mode, click on the **Design** tab.
- **Export**: Use to export the report contents. i.e. export to another application, HTML, disk, e-mail server, text file, etc.
- **Refresh**: Use Refresh to refresh the data being used on the report for changes made since last preview.
- **Preview Pane**: Use this to view the group tree in the Preview of the report.
- **Field Explorer**: Use to insert database fields and other options included in the Field Explorer. The field explorer can be used to insert or create new items. Other options include: Formula fields, SQL Expression Fields, Parameter Fields, Running Total fields, Group Name fields and Special Fields.
- **Report Explorer**: Use to see the content of a report in a tree view.
Repository Explorer: Use to toggle on and off the Crystal Repository, which contains objects such as text objects, bitmaps, and custom functions.

Insert Text: Use Text Objects when you need to have text appear on the report. Text objects hold text (a single character, a single word, entire sentences, or an entire letter). A text object can hold database fields and formula fields as well as text.

Insert Group: Use Groups to sort and group data in a meaningful way. Groups also allow for totals and subtotals.

Insert Summary: Use the Summary command to summarize data and print the summary in your report. The program sorts, groups and summarizes in a single step. Use summaries for:
- Counting the number of values in a group
- Calculating the sum, average, standard deviation, or variance value in a group
- Identifying the minimum or maximum value in a group.

Insert Subreport: A subreport is a report within the main report that runs separately. A main report can contain multiple subreports.

Insert Chart: Use to access the Chart Expert and choose from among four types of Charts: simple group chart, detail/formula chart, cross-tab chart, or an OLAP chart.

Section Expert: Use the Section Expert to make formatting changes that affect entire sections of your report.

Select Expert: Use the Select Expert to choose records or groups to include in your report (if you do not want them all included). This is similar to placing conditions on a report.

Sort Order: Use the Sort Order to define how the records in your report should be sorted for printing. You can add and remove sort fields and define the sort direction, ascending or descending, for the data in your report.
Special Fields

Under the Field Explorer and in other areas of Crystal Reports, there is a list of available fields called **Special Fields**. These fields can be added to any section of a report and used in formulas. You can display information such as Page Numbers, Print Date, and Report Comments. Typically, these fields would be printed in the Report or Page Header(s) and Report or Page Footer(s). It depends on how often you want them to print.
Field Explorer:

<table>
<thead>
<tr>
<th>Special Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used for:</td>
</tr>
</tbody>
</table>

Explanation of some *Special Fields*:
| **Page Number** | Current page number. |
| **Total Page Count** | Total page count at the end of the report. |
| **Page N of M** | Current page number of total pages. |
| **Report Title** | Contains the title specified in the Summary Info on the File menu. |
| **Report Comments** | Contains the comments specified in the Summary Info on the File menu. Only the first 256 characters print. |
| **Print Date / Time** | Current date and/or time from workstation settings when the report is printed. |
| **Record Number** | Numbers each record printed in the Details section. |
| **Group Number** | Numbers each group in your report. |
| **Record Selection Formula** | Inserts a record selection formula field into your report. |
| **Group Selection Formula** | Inserts a group selection formula field into your report. |
Activity 4: Use your report 3 as a basis for these changes:

- Save as Report 4.
- Add page number N of M to the right side of the page footer in your report.
- Decrease the size of the font and right justify.
- Add the File Path and Name to the Page Footer section at the left edge.
- Decrease the font size and change the color of the font to a gray so that it is lighter.
- Print Preview to make sure the report is looking, as you would like it to.
- Save again and preview.
File and Design Options

This section discusses the following:

- Default Settings for Options
- Working in a Report
- Formatting Reports
- Inserting Text Objects
- Inserting Lines and Boxes

Default Settings for Options

Under File, Options you can set the default settings for your reporting environment. Settings can be changed for each area on the tabs available: Layout, Database, Formula Editors, Reporting, Fields, Fonts, Smart Tag, and Dependency Checker.
**Layout tab**

<table>
<thead>
<tr>
<th>DesignView Options:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rulers</td>
<td>A ruler can be shown at the top of the window.</td>
</tr>
<tr>
<td>Guidelines</td>
<td>Guidelines can be displayed in the window.</td>
</tr>
<tr>
<td>Grid</td>
<td>A grid can be displayed in the window.</td>
</tr>
<tr>
<td>Tool Tips</td>
<td>Decide if Tool Tips should appear in the design window.</td>
</tr>
<tr>
<td>Short Section Names</td>
<td>Section names can be abbreviated to increase the work area.</td>
</tr>
<tr>
<td></td>
<td>Detail='D', Report Header='RH', etc.</td>
</tr>
<tr>
<td>Show Hidden Sections</td>
<td>Hidden sections can be controlled to appear with gray background.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Grid Options:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Snap to Grid</td>
<td>Mark to automatically align inserted or resized fields to the</td>
</tr>
<tr>
<td></td>
<td>nearest grid coordinate.</td>
</tr>
<tr>
<td>Grid Size</td>
<td>Changes the size of the grid. Enter values between .011 and 1</td>
</tr>
<tr>
<td></td>
<td>inch.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Options:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Field Names</td>
<td>Mark to show field names for each report field; otherwise XX,</td>
</tr>
<tr>
<td></td>
<td>99, etc., display depending on the field type.</td>
</tr>
<tr>
<td>Insert Detail Field Names</td>
<td>Mark to insert field titles in the Page Header section whenever</td>
</tr>
<tr>
<td></td>
<td>you insert a field in the Details section of the Design tab.</td>
</tr>
<tr>
<td>Insert Group Name with Group</td>
<td>Mark to automatically show the Group Name in the Group Header</td>
</tr>
<tr>
<td></td>
<td>whenever you insert a new group.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Preview:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rulers, Guidelines, Grid, Tool Tips</td>
<td>Displays each feature in the Preview window.</td>
</tr>
<tr>
<td>Section Names</td>
<td>Mark to display section names in the Preview window. When not</td>
</tr>
<tr>
<td></td>
<td>marked, the entire width of the Preview tab is used to display</td>
</tr>
<tr>
<td></td>
<td>the report page.</td>
</tr>
<tr>
<td>Page Breaks in Wide Pages</td>
<td>Mark to show indicators on the Preview tab for page breaks in</td>
</tr>
<tr>
<td></td>
<td>wide pages</td>
</tr>
<tr>
<td>Display Group Tree</td>
<td>When groups exist on the design, mark to show the tree with</td>
</tr>
<tr>
<td></td>
<td>values on the Preview window.</td>
</tr>
</tbody>
</table>
Guidelines are important tools in lining up multiple fields. When fields are attached to a guideline, all of those fields can be moved at once by clicking and holding the small triangle. Moving guideline markers out of the ruler make the guideline disappear. Guidelines cannot be moved to attach fields; the fields must be moved to attach to the guidelines.

Clicking in the horizontal or vertical ruler creates guidelines. A small triangle and a gray dashed line appear on the design window. Any field on the report can be attached to a guideline.

Grid size pixels – display when Grid in Design View or Preview is marked.

Gridlines – display when Guidelines in Design View or Preview is marked.
Database Tab

Use the **Database** tab for many database options including the default sort for Tables and Fields.
Formula Editor Tab

Use the **Formula Editor** tab to customize formatting options for the text you create in editors such as the Formula Editor.
Reporting Tab

Use the **Reporting** tab to select global settings for reading and saving data.

If **Save Data With Report** is marked, the data is a snapshot in time and will be compressed with the report.
Fields Tab

Use the *Fields* tab to set default formats for each field type.

Formatting options change for each type, but all types include options for: Common, Border and Hyperlink.
Common Tab
Unique to Data Types
Fonts Tab

Use the **Fonts** tab to set the defaults for fonts on different types of objects.
Smart Tag Tab

Use the **Smart Tag** tab to define the web server and viewing page you want to use when selecting MS Office smart tags for Crystal report objects.

All these Options will be used for each new report you start. If you take the time to go through each one and set them up the way you want, it will save hours of time over time and make each report you build have the same fonts, currency rules and overall look and feel.
Select Features

This section discusses:

- Conditioning Reports – Select Expert
- Sorting Records
- Grouping Records

Conditioning Reports (Select Expert)

Select Expert places conditions or criteria on the data that is displayed in your report. This is very similar to using conditions in Sage 300. To access the Select Expert, go to the icon on the toolbar or Select Expert from the Report menu. Choose a field that is on the report from the Report Fields: selection or go to the appropriate table to find the field to be conditioned.

Click [OK] when a field is selected. Another window displays to create the condition(s).
Notes:

- Criteria fields do not have to be on the report.
- You can only apply one criteria option to a specific field.

Comparison Types for Conditions:

is any value.

is equal to

is not equal to

is one of

is not one of

is less than

is less than or equal to

is greater than

is greater than or equal to

is between

is not between

starts with

does not start with

is like

is not like

"is like"/"is not like" can be used with wildcards * or ?

Values to compare to can come from the data when available using Browse Data. Otherwise, you must enter the value you are conditioning for.

Tip! If you are not sure how a field is stored, use Browse data on the field list, right-mouse context menu, to find the comparison value.

You can also view or edit the formula being applied by this condition by using the Show Formula button.

To add additional criteria, use the <New> tab. This starts the process over again. When you add a second formula, the system assumes the connection is “and”. To combine two conditions using an “or”, go to Show Formula and change the “and” to an “or”.

Note: When highlighted on a field at the time Select Expert is chosen, the system assumes the condition is going to be based on that field. It prefills the tab with the field name. If this is not the field to be conditioned, click the [Del] button to remove and then [New] to select the correct field.
Activity 5: Use Report 4 and make the following changes:

- Save as Report 5.
- Add criteria to include only invoices with open status.
- Preview the report.
- Add another condition to include vendors between 100 and 300. This may not work on your live data, as you may not have Vendor ID’s that use numbers. Therefore change this to letters in that case.
- Refresh your data print preview.
- Save again and preview.
Saving as Landscape

To save a design in Landscape for increased width, go to File, Page Setup and select Landscape.
Additional Design Info

To find additional information about the design and assign a title and report comments, go to [File] > [Summary Info]. The statistics show the number of times the report has been opened for modifications as well as the modification time elapsed.
Sorting Records

You can specify in what order records should process in the report. Select the field(s) to sort by and whether to print in Ascending (A) or Descending (D) order. The fields used in the sort can be a Report Field, Database Field or formulas.

**Notes:**

- In multiple field sorts, records are sorted based on the values in the first field selected, putting them in ascending or descending order as specified. When two or more records have the same field value in the first sort field, the program then sorts those records based on the value in the second sort field.
- When Groups are added, they become the first fields in the sort automatically.
Activity 6: Use Report 5 and make the following changes:

- Save as Report 6.
- Remove the criteria placed on the report in Activity 5.
- Sort the report to print in Invoice number order.
- Save again and preview the report.
- Try adding another sort for a field that is not an actual report field, i.e. invoice date, Vendor Type, etc. You may need to add another table to the report if you want to sort on a field from that table.
- Save again and preview.
Linking

Linking is the process used to identify the relationship between two tables that store related information on a report. It is best with Sage 300 data files to manually create the links necessary when the design has more than one database table on it. When a design is created using multiple tables, the Links tab of the Database Expert appears for setting up the links necessary between them.

Crystal Reports 2013® has an option called SmartLinking that automatically creates what it considers “logical” links for the records selected based on similar field names. This is not the recommended method for Sage 300 because the same field exists on multiple records, but is not a part of the keys to those records. Use the Clear Links to remove any links and assign the links manually.

Each time a new report is begun, the links should be assigned. Linking can be done later from the Database Expert by selecting the Links tab.

Select the tables for your report by highlighting each table and click the add arrow. When you have finished, click [OK] to view the Links window.
Use the Clear Links button to remove automatically assigned links.
To link fields manually, highlight the field to link and drag the mouse to the field it links to on the other table. You must do this for each field to link and every table it links to. Typically, you start the drag from the more detailed table, or the table Sage 300 Reporter would consider your processing record.

The current link that you are working with is highlighted in blue; all other links will be black.
[Auto-Link Tables:] option allows you to choose By Name or By Keys to automate the process, then remove unnecessary links later. This is not recommended, as it is the same as using Auto SmartLinking.

[Order Links] allows you to choose the order in which the links are processed. This is an advanced topic and can be ignored for now.

[Clear Links] Removes all links that have been created. You will receive a warning question, “Are you sure you want to remove all the links?”

[Link Options] allows you to make changes to the type of link. In some cases, links must be forced using a different Join Type and/or Link Type to return all the values expected.

**Join Types**

**Inner Join** ➔ An Inner join is the standard type of join. The result set from an Inner join includes all the records in which the linked field value in both tables is an exact match.

**Left Outer Join** ➔ The result set from a Left Outer join includes all the records in which the linked field value in both tables is an exact match. It also includes a row for every record in the left table for which the linked field value has no match in the right, or lookup, table.

**Right Outer Join** ➔ The result set from a Right Outer join includes all the records in which the linked field value in both tables is an exact match. It also includes a row for every record in the right table for which the linked field value has no match in the left, or primary, table.
### Link Types

**Equal link**
- The result set from an Equal link includes all the records where the linked field value in both tables is an exact match.

**Greater Than link**
- The result set from a Greater Than link includes all records in which the linked field value from the left, or primary, table is greater than the linked field value in the right, or lookup, table.

**Less Than link**
- The result set from a Less Than link includes all records in which the linked field value in the left, or primary, table is less than the linked field value in the right, or lookup, table.

**Not Equal link**
- The result set from a Not Equal link includes all records in which the linked field value in the left, or primary, table is not equal to the linked field value in the right, or lookup, table.

[Index Legend] denotes the colors used for each type of index/key field.
Verify Database

Use the **Verify Database** command to make certain your reports print with the current version of the active database. When you first create a report, the report draws its fields from the database as it exists at that time. It uses the structure of the database (number of fields, field position, data type, and so on) to determine how that field prints on the report. If the database changes, where fields are changed, added or removed after the report was created, Crystal Reports needs to be manually updated with the changes through the **Verify Database** command:

- If the database has more fields now than it had when the report was first created, Crystal Reports attempts to identify and use the correct fields from the new database.
- If the database has fewer fields now than it had when the report was first created, it uses those fields that are still available when it prints the report and ignores those that are no longer available.

When you choose **Verify Database** from the **Database** menu in Crystal, it checks the databases as compared to the report and any changes detected are reported. If it detects changes in the database, the report must be adapted to prevent future error messages. A window appears to let you know there was errors found and would you like to fix them? If you respond **Yes**, the program attempts to adapt the report to the new database structure.

![Verify Database dialog](image)
Note: You will get a message similar to this on every table that has changed since the report was originally created. In addition, you may be asked to identify where to look for the database source.
Activity 7: Use Report 6 and make the following changes:

- Save as Report 7.
- Open up the Database-Database Expert and add the APM_MASTER__VENDOR table to the report.
- Click [OK].
  - You will be taken to the Links tab.
- Click the button on the right named “Clear Links”.
- Drag the Vendor from the Left Table (Invoice) to the Right Table (Vendor) dropping the vendor field from the Invoice on top of the Vendor Invoice field.
- Make sure the Link type is an Inner Join.
- Click [OK] when you are done.
- Preview the report to make sure you have not lost or gained any records.
- Save the Report again.
Grouping Records

Use grouping to put information into meaningful sections and allow for totals based on a group. Groups are placed by Group number as the first fields in the sort order. To create a group, choose Group from the Insert menu. Or use the Insert Group button on the Supplementary Toolbar. A dialog box with Common and Options tabs appears to set up the groups. To place a second group on the report, go to Insert Group and make selections for the next grouping. The fields you choose for Grouping do not have to be Report Fields.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort and Group by</td>
<td>Select the field on which the group is going to be based. The list displayed includes Report Fields and Formulas.</td>
</tr>
<tr>
<td>Order</td>
<td>Select your sorting option. There are four choices: In ascending order: A to Z, 1 to 9, etc. In descending order: Z to A, 9 to 1, etc. In specified order: Allows you to create a group based on a value other than one from a field in the database. Once selected, another tab appears to set the specified order. In original order: the same way it is in the database</td>
</tr>
<tr>
<td>Customize Group Name Field</td>
<td>Use this to choose a name different than the default for the Group. For example, you may want to group by Vendor ID, but use the Vendor Name as the Group Name field.</td>
</tr>
<tr>
<td>Keep Group Together</td>
<td>Mark this option to keep the group together on a page. If the records go onto more than one page, this option forces them to be printed together on the next page.</td>
</tr>
<tr>
<td>Repeat Group Header on Each Page</td>
<td>Mark this option to reprint the Group Header on each page when the number of records crosses more than one page.</td>
</tr>
</tbody>
</table>
Notice the Group Header #1 and Group Header #2 sections that appear when Grouping is added to the report. Select Change Group from the context menu when you right-mouse click in the gray area of the Group. In addition, Groups also create additional sections on the report. Use Section Formatting options to modify the section.

To access the group for modifications later, right-mouse click on the group section area for the context menu and select Change Group:
Preview Pane (AKA Group Tree)

The **Preview Pane** is available when previewing a report. You can toggle it on/off using the Preview Pane icon on the formatting toolbar. It shows a high level outline of the report, with the hierarchy of Groups and Subgroups. By clicking on the value in the Preview Pane, the preview goes to that area of information in the report.
USING THE GROUPING FEATURE

Activity 8: Use Report 7 and make the following changes:

- Save as Report 8.
- Verify all selection criteria have been removed that was set on previous reports.
- If you haven’t already done so, add the Vendor table to the report and link the Vendor ID from the Invoice table to the Vendor table. Make sure to clear the automatically created links and then create your own.
- Group by Vendor ID, sorted in ascending order
- Customize with the **Vendor Name** as the Group Name field (rather than Vendor ID)
- Save again and preview the report.
- Add another Group for **Status** in ascending order.
- Delete the **Vendor ID** field out of the details section.
- Save again and preview.
Summaries

A Summary has multiple uses. One of the primary purposes for breaking data into groups is to run calculations on each group of records instead of on all the records in the report.

When the program summarizes data, it sorts the data, breaks it into groups, and then summarizes the values in each group. The program includes a number of summarizing options. Depending on the data type of the field you plan to summarize, you can:

- **Sum** the values in each group
- **Count** all the values or only those values that are distinct from one another
- Determine the **Maximum, Minimum, Average**, or **Nth largest** value
- Calculate up to two kinds of standard **Deviations** and **Variances**.

There are several ways to access the Summary option:

- Right click on the field to be summarized, select Insert, Summary from the context menu
- Highlight the field, then select Summary from the Insert menu
- Highlight the field, then use the Summary bitmap from the Standard toolbar
Choose the field to summarize:

APM_MASTER_INVOICE.Amount

Calculate this summary:

Sun

Summary location

Grand Total (Report Footer)

Add to all group levels

Insert Group...

Options

Show as a percentage of

Summarize across hierarchy

Choose to calculate the: (Bold/Italics are most common)

- **Sum**: Adds the values that appear in the report
- **Average**: Averages the values that appear in the report
- **Maximum**: Returns the largest value in a group
- **Minimum**: Returns the smallest value in a group
- **Count**: Counts the # values that appear in the report for a specified field
- **Sample Variance**
- **Sample Standard Deviation**
- **Population Variance**
- **Population Standard Deviation**
- **Distinct Count**: Counts the # of distinct values that appear in a report for a specified field. This is used when a value may be repeated in the group but you only want to count it once.
- **Correlation**
- **Covariance**
- **Weighted Average**
- **Median**
- **Pth Percentile**
- **Nth Largest**: Determines the Nth largest value in a group/report
- **Nth Smallest**: Determines the Nth smallest value in a group/report
- **Mode**
- **Nth Most Frequent**
### Field | Description
---|---
**Summary location** | This list contains the locations in your report in which you can place a summary. Every report can contain a Grand Total. If you want to add a different kind of summary, such as a subtotal, select the existing group, or add a group using the Insert Group button.

**Show as a percentage of** | Select this check box if you want to calculate the percentage total of one group within a broader grouping.

**Summarize across hierarchy** | This option enables you to calculate a summary across hierarchical groupings. (See Grouping data hierarchically in Help for more information).

### Change Summary Field

To change a Summary once it has been placed on the report, highlight on the field and right-mouse click. Then select **Edit Summary** operation from the context menu.

Make your changes as necessary.
Edit Summary

Choose the field to summarize:

Calculate this summary:

Options:
- Show as a percentage of:
  - Grand Total: Sum of Amount
- Summarize across hierarchy

OK  Cancel
Activity 9: Use Report 8 and make the following changes:

- Save as Report 9A.
- Insert a sum type summary to create subtotals for the invoice amounts for both groups
- Insert a count of the number of invoices per vendor – print without decimals
- Insert text labels for each summary
- Save again and preview. (Bronson Signs has both Open and Paid Invoices)
Continued:

- Save as Report 9B.
- Add a field to the report that will show the total number of vendors on this report – print without decimals.
- Add another field that shows the grand total of the amount (if not already on the report).
- Add text labels for each count.
- Format the labels and grand total fields to stand out on your report.
- Save again and preview.
Formulas

You can create, edit, rename and delete formulas. The method to do this is through the Formula Editor. You can access this through the Field Explorer, Formula Fields, and right-mouse click. Or, choose Formula from the Edit menu.

Click on New, and then enter the formula name. This name displays with an @ symbol in front on the report where the field is used and also in field lists.
**Formula Display**

Three sections display in the formula editor window for trees. They can be independently hidden from the main formulas window. If one is hidden and you want to display it again, click on the appropriate option button on the toolbar. The three “tree” sections appear on the toolbar in the order they typically appear on the window: *Field Tree, Function Tree, and Operator Tree*. When not displayed, they will appear as if they aren’t depressed on the toolbar.

In addition, the width of each section can be adjusted by clicking on the section separator, holding the mouse down and sliding it right or left to change the width. You can also change the depth of the area by grabbing the lower portion of the grid and dragging.

Vs. only two trees of the three displayed
Formula Editor Window

There are four main areas of the Formula Editor window:

**REPORT FIELDS:** All Report Fields, Database fields, and other Formulas that are available for the report display in the far left section. When you right-mouse click on the Report and Database Fields, you can browse data values if desired.

**FUNCTIONS:** A function is a built-in procedure or subroutine used to evaluate, make calculations on, or transform data. When you specify a function, Crystal Reports performs the set of operators built into the function without needing each operator specified separately. In this way, a function is a kind of shorthand that makes it easier and less time consuming for you to create reports. All Functions available for use in Formulas are listed in this middle section.

<table>
<thead>
<tr>
<th>Function Tree Grouping</th>
<th>Includes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Math</td>
<td>items like: Abs, Sin, Cos, Round, Trunc, etc.</td>
</tr>
<tr>
<td>Summary</td>
<td>items like: Sum, Count, DistinctCount, Maximum, Minimum, etc.</td>
</tr>
<tr>
<td>Financial</td>
<td>items like: Pmt, FV (Future Value), IPmt (Interest Payment), etc.</td>
</tr>
<tr>
<td>Strings</td>
<td>items to manipulate string fields like: Length, ToText, Mid, InStr (In String), etc.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>items to manipulate Date fields like: formatting dates, ToString, Year, Month, Day, DayOfWeek, etc.</td>
</tr>
<tr>
<td>Date Ranges</td>
<td>items to return from a range of dates like: MonthToDate, Last7Days, Aged0to30Days, etc.</td>
</tr>
<tr>
<td>Arrays</td>
<td>items used to build a list of data fields, constants or text strings that are used for checking to see if a field exists in the list. Functions like Sum, Maximum, Minimum, Count, DistinctCount, etc.</td>
</tr>
<tr>
<td>Type Conversion</td>
<td>items to covert from one type of field to another like: CCur, CStr, CDate, etc.</td>
</tr>
<tr>
<td>Evaluation Time</td>
<td>items for when to evaluate records that follow like: BeforeReadingRecords, WhileReadingRecords, WhilePrintingRecords, etc.</td>
</tr>
<tr>
<td>Print State</td>
<td>items for figuring what the print status is and ability to print page in certain format like: Next, IsNull, PageNumber, PageCount, PageNoF, etc.</td>
</tr>
<tr>
<td>Document Properties</td>
<td>items to control printing information on the document that isn’t available on the database, things like: PrintDate, PrintTime, ModificationDate, Filename, etc.</td>
</tr>
<tr>
<td>Additional Functions</td>
<td>items not under any other heading that may be needed, like: SquareRoot, Picture, StoreStringVar, etc.</td>
</tr>
</tbody>
</table>
OPERATORS: An operator is a special symbol that describes an operation or an action to take place between two or more values. The symbol / for example, is an operator that means divide. A/B means divide A by B. Crystal Reports reads the operators in a formula and performs the actions specified. All Operators that are available for Formulas are listed in the right section grouped by type.

<table>
<thead>
<tr>
<th>Operator Type</th>
<th>Used to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arithmetic</td>
<td>calculate number or dollar values.</td>
</tr>
<tr>
<td>Conversion</td>
<td>convert one data type to another.</td>
</tr>
<tr>
<td>Comparisons</td>
<td>compare data in a data field with a constant, with the content of another data field, or with a formula result.</td>
</tr>
<tr>
<td>Strings</td>
<td>concatenate (join) text strings, to extract sub strings from text strings, or to test for the presence of sub strings in text strings.</td>
</tr>
<tr>
<td>Ranges</td>
<td>create ranges and to see if a value is within the range created. They test for consecutive values such as dates, text, or amounts that fall within a range.</td>
</tr>
<tr>
<td>Boolean</td>
<td>create conditions that require a logical relationship between two or more values. Conditions using Boolean operators are called Boolean expressions.</td>
</tr>
<tr>
<td>Arrays</td>
<td>build a list of data fields, constants, or text string. These lists can then be used for checking to see if a field exists in the list, or for extracted elements by their position. Whereas the Range operators are used to see if an item exists in a range of values, these array operators allow you to see if an item exists in a set of non-contiguous values.</td>
</tr>
<tr>
<td>Pattern</td>
<td>compare strings to a given pattern. They are useful operators for selecting records based on part of a string (Like pattern operator) or based on a partly unknown string (Starts with operator).</td>
</tr>
<tr>
<td>Control structures</td>
<td>control the flow of logic in a formula. You can use them to build formula setting conditions that, if met, trigger specific consequences or repeat a sequence of actions under certain conditions. An example would be IF THEN ELSE statements.</td>
</tr>
<tr>
<td>Other</td>
<td>assign values to variables, indicate an order of precedence in which calculations are to be performed, separate comments from formulas, define date constants, or call a function.</td>
</tr>
<tr>
<td>Scope</td>
<td>tell the system where variables can be referenced. Local, Global and Shared are the three scopes.</td>
</tr>
<tr>
<td>Variable Declarations</td>
<td>define a variable by giving the variable a name. You can also assign a value to a variable when you declare it by using the Assignment operator.</td>
</tr>
</tbody>
</table>
Formula Creation

The bottom section of the window is the formula creation area. To create a formula, select the fields, functions and operators from the lists provided or type them in if you know what they are. When data fields are selected, they appear with brackets “{ }” at the start and finish of the field name. Once Crystal recognizes something being typed is a Function, it displays it in blue on the formulas window.

Formulas can be used in producing fields on a report, to conditionally format fields, to conditionally format different report sections, to condition the records to be included on the report, sort order, and for grouping purposes. **Note:** While editing formulas, Cut, Copy, Paste, Undo and Redo are available to use.

```
{MASTER_APW_INVOICE_Amount}-{MASTER_APW_INVOICE_Amount_Paid}
```
Editing Formula Options

There will be several ways to access a formula for editing. Use one of the following options:

1. If the formula has been used on the report as a field, right-mouse click on the field from the Design or Preview window and select Edit Formula from the context menu.

2. Second method when the formula is on the report as a field, highlight on the field and select Edit Formula from Edit menu. This will only be available when you are on a field that is a formula.

3. If the formula has not been used on the report, go to Insert Fields to access the Field Explorer window. Expand the Formulas grouping; find the formula and right-mouse click. Select Edit from the context menu.

The following are toolbar functions most often used in formulas:

- **Close**: Close the formula editor window. It will also prompt you to save and tests the formula for accuracy.

- **New**: Use to create a new formula.

- **Rename**: Use to rename a formula.

- **Delete**: Use to delete a formula.

- **Save**: Save the formula. It also tests the formula for accuracy.

- **Check**: Tests the syntax of the formula and identified what and where the problems are.

- **Undo**: Undoes the last task.

- **Redo**: Redoes the last task.

- **Browse Data**: Available when you highlight on a Report Field on the list.

- **Sort**: Use to sort the fields or list in alphabetical order.
**Comment Selected Text:** use to indicate that the selected text is a comment and is not to be evaluated as part of the formula.

**The Basics**

Formulas have basic functionality like other applications.

- The typical arithmetic operators can be used:
  - Add (+)
  - Subtract (-)
  - Multiply (*)
  - Divide (/)
  - Per cent (%)
  - Negative (-)

  For example to create a column on a report that is the open balance for and invoice: `{APM_MASTER_INVOICE.Amount}-{APM_MASTER_INVOICE.Amount_Paid}`

- To force the system to make one calculation before another, parentheses “( )” can be used around the first calculation.

- As database fields are selected, they will be placed in the formula with brackets “{ }” around them.

- In Crystal Reports, sometimes parentheses “( )” are required when working with Functions and Operators and sometimes brackets “[ ]” are required. If the formula appears to be correct, but you receive the message “The remaining text does not appear to be part of the formula” try using brackets instead. An example where brackets are used is with **Subscripts**.

- When writing a formula that compares fields with stored values, use [Browse] to view the values and add to the formula: e.g. Invoice Status= “Open” or Vendor Type= “Summary”.

- All pieces of the formula do not have to be pulled into the formula on one line. The enter key can be used in the middle of a formula to keep the formula visible on screen.

- **Comments** are additional information about the formula that should not affect the formula. These can be added above or below the formula or on the same line using any of the following:
  - If on the same line, precede the comment by a colon (:).
  - Use a line continuation character (“_”) within comment to carry it to the next line.
  - Use the comment operator (//).
Introduction To Formulas

Activity 10: Use Report 9b and make the following changes:

- Save as Report 10.
- Add “Amount Paid” from the Invoice Table to the right side of the report in the detail section.
  - This may require you bunch things up a bit closer or you may have to turn the page to landscape.
- Create a new formula called “Balance”.
- The Balance formula will take the Invoice Amount minus the Invoice Amount Paid fields from the Invoice table.
- Once you have built the formula, drag it too into the design at the far right. Place it in the details section.
- Make sure your column headers have been formatted to look similar to other column headers in size, font and overall appearance.
- Add Subtotals to both the Paid Amount and Balance Columns for Vendor, Status and Report sections.
- Save again and preview
Integration Formulas

Overview

In this section we will cover:

- TSDesignMode Formula
- TSDataFolder Formula
- Why do I need them?
- Why C:/TsData? And what does it mean.
- We will edit canned reports to understand above functions.

TSDesignMode

TSDesignMode—really stands for **Table and Field Naming**. When you setup your ODBC DSN, remember the Magical One! Well when you set it up you need to pick which design mode you want to write your report in. By default it is set to Custom. Though there is nothing wrong with custom it isn’t considered the best mode to write reports in. This is primarily because all the cool integration formulas covered in the Crystal.pdf, available from the Sage 300 Help menu, **DO NOT** work in custom mode. Therefore, Standard mode is now almost universally used by all consultants and most clients. In addition all canned Accounting and Project Management reports are also created in Standard mode. So let’s talk about the three possible modes available when writing reports for Sage 300 Accounting and Project Management.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Only good time to use this mode is when you are going to build it for only one database. Only viable for clients. The best thing about Custom mode is you see all the custom naming done in your database. If you have renamed Job to Project, you’d see the renaming while building reports.</td>
</tr>
<tr>
<td>Standard</td>
<td>Must be used if the report is going to be used on multiple databases. Internal standard names are always seen regardless of renaming done in a particular database. Best reason to use this mode is because all the integration formulas and features work in this mode while not in others.</td>
</tr>
<tr>
<td>Dictionary</td>
<td>This is the old original Standard Mode and is used on all Billing Invoices built in Crystal. It is the least friendly mode and almost no one uses it anymore unless they are editing a Billing Invoice.</td>
</tr>
</tbody>
</table>

In Crystal we create a formula named “TSDesignMode” and within that formula we put either “SDesc” or “Dictionary” depending on which of the two modes we pick. If we picked Custom when setting up the ODBC DSN, we **DO NOT** put this formula on the report. In other words, Sage 300 expects Custom unless otherwise told by this formula inside Crystal. This formula does not need to be on the face of the report but rather just be in the list of formulas on the Crystal Report.
TSDataFolder

TSDataFolder—is a formula on each canned report. It is not required on any report you create by yourself. The advantage to this formula and the reason you may want to use it on your reports is the following. Sage 300 has created many custom functions that pull specific data from within your database without having to pull in those tables and or creating links and maybe subreports. These functions all require the report to tell them where the data is located. The formula that tells all these other formulas containing Sage 300 functions is named @TSDataFolder. Within this formula you place the path to your live data folder. You’ll notice in all canned reports the path says “C:\TSData”. The most common question by those learning Crystal for Sage 300 is why C:\TSData? The reason is simple, that’s where the data was for the person who built the Canned Reports back at the Sage 300 Sage 300. In fact there is nothing special about that location. While you are editing canned reports and trying to test them in your Sage 300 you’ll want to change the path to point where your data is.

When a report is run from within an application such as Project Management, Sage 300 quickly (OK, some would say not so quickly) opens the report behind the scenes and changes the path from “C:\TSData” to the location of your live data. However, when testing from within Crystal as you and I will do, Crystal isn’t so smart so we must change the location ourselves.

**Note:** TSDatafolder is only required if you use one of these custom functions. Many reports you write will not include any custom function and therefore you do not need to have this formula on your report.

The most common function used on canned reports is the tsControlData. It is used to pull the overall Company name and address located in the General Tab.
Summary

Throughout the previous pages you have learned some basic techniques about Crystal Reports that will greatly help you while you build and modify existing reports for Sage 300. However, all these skills are transferable to any other database software that you use now or in the future. Crystal Reports works with thousands of software packages around the world. Once mastered you will have a valuable skill that you can take with you the rest of your working career. Be sure to put that skill on your resume, as it is truly valuable.

I hope you’ve enjoyed this class and will take what you’ve learned today and continue to build upon it. Though these activities seemed easy, if you don’t practice them they will feel like a foreign language just weeks from now. So practice and then practice some more. Once you’ve mastered these skills you will be ready for more training including Beyond the Basics, Advance Crystal Reports and SQL’izing your Reports.

If you need any assistance please do not hesitate to contact us at Progressive Reports. We are dedicated to getting you the answers you need from your data!
Progressive Reports

Getting the Answers